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You can use Adobe Reader version 7 or higher to view the Installation Guide. For 

best viewing, use version 8 of Adobe Reader. 

See next page for Adobe Reader version 7 viewing instructions.

To view the Installation Guide in Adobe Reader version 8, 

1. Ensure that all of the components within the PDF are displayed by selecting the 
View left icon.

2. From the left frame, click a specific link for a product.

3. From the Bookmarks frame, click a link to navigate within the specified release 
notes. If the frame is minimized, click the Bookmarks icon. 
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To view Installation Guide in Adobe Reader version 7, 

1. Click the Attachments tab.

2. In the bottom frame, double click a link to view a PDF file.

5. Close the PDF document in Adobe reader 7, but do not quit Adobe reader.

6. If necessary, click the Attachments tab to view the PDF package contents.
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Installing Saber View


This document contains specific information to prepare for and verify installation 
of Saber View.


Install the latest version of Saber in a folder that does not contain an existing 
installation. A common license can serve multiple versions of Saber.


Note:   The installation instructions in this document are the most up-to-
date available at the time of production. However, changes might 
have occurred. For the latest installation information, see Saber 
release notes or documentation on SolvNet.


This section covers the following topics:
■ Installing the Software
■ Verifying the Installation
■ Uninstalling Saber View


Installing the Software


Ensure to close any open Saber applications before proceeding with the 
installation.


To install Saber View:


1. Download the Saber release to a temporary directory. You can obtain the 
latest Saber download instructions from the Release Library, which is 
accessible through SolvNet.


2. Select the Saber Harness option for installation while installing Saber in 
addition to other typical Saber components.

Saber View Installation Guide 1
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Chapter :
Verifying the Installation

For the latest installation information, see the Saber Installation Guide at: 
http://www.synopsys.com/Support/LI/Installation/Pages/default.aspx. 


Note:   C:\Synopsys\Saber\<version> is the default install location 
unless you choose a different location.


3. Extract the contents of v2009.2.4.1.zip available from the location 
<Saber_Install_path>\Synopsys\Saber\<version>\Saber\saberview\ to a 
temporary location.


4. Navigate to the <Temporary_Location>\v2009.2.4.1\ folder and double-
click install.bat.


The Saber View installer performs the following tasks:


• Creates a progam installation directory, C:\Program Files\TTA\Netlist 
unless you choose a different location. 


• Creates the following icons on the desktop:


• License Control: Launches licenses utility (Admin use only)


• WebUI: Web-Based NetList Converter Application (Admin use only)


• Netlist: Launches the SaberView rendering application (Users)


Verifying the Installation


Saber View requires only a single license daemon, snpslmd. For additional 
information, see Installing Synopsys Tools.


To run Saber View View:


1. Check that your SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE variable 
is set to a valid licensing server. If you do not have a license, contact 
Customer Support to obtain one. 

2 Saber View Installation Guide
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Chapter :
Verifying the Installation

2. Either double-click the WebUI shortcut icon from the desktop or double-click 
<SaberView_Install_Path>\TTA\Netlist\WebUI.exe. The Saber View window 
is displayed:


3. To launch Saber View, either click File > Execute or click  from the webui 
Server toolbar. The Saber View login page is displayed:


4. Enter the login credentials supplied by the Synopsys Technical Support to 
start using Saber View.


If you do not have a valid login credentials, contact Customer Support.

Saber View Installation Guide 3
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Chapter :
Uninstalling Saber View

Uninstalling Saber View


To uninstall the software, select and delete the Saber View installation folder 
(C:\Program Files\TTA\).

4 Saber View Installation Guide
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Installing SiVL


This document contains the following sections: 


Note:   


The installation instructions in this document are the most up-to-date 
available at the time of production. However, changes might have occurred. 
For the latest installation information, see the product release notes or 
documentation. 


■ Media Availability and Supported Platforms
■ Disk Space Requirements
■ Installing the Software
■ Setting Up the User Environment
■ Setting Up SiVL to Use Hercules and IC WorkBench Plus
■ Verifying the SiVL Installation


To run the SiVL tool, the Hercules and IC Workbench tools must be installed 
and running. See Installing Synopsys Tools, available at http://
www.synopsys.com/support/installation/install_guide.html. 
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Installing SiVL
Media Availability and Supported Platforms

Media Availability and Supported Platforms


The SiVL tool is available by EST. Obtain the appropriate binary executable 
files based on the operating system you need. Table 1 shows the supported 
platforms for this release.


Note:   


The SiVL software is configured so that multiple platforms of this version can 
be installed in a single installation directory (install_dir).


Disk Space Requirements


The disk space requirement varies depending on the platform and the tool 
selected for installation. Table 2 shows the maximum space required for 
installing each product on a particular platform. (The total for all platforms is 
185 megabytes, including 15 megabytes for the common file.)


Table 1 Platforms and Keywords 


Platform Operating system Synopsys platform 
keyword


Path 
keyword


AMD Opteron                        Red Hat Enterprise Linux v4
(Taroon update 5)


amd64 (64-bit mode)     AMD.64


IA-32 (X86) Red Hat Enterprise Linux v41


(Taroon update 5)


1. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.


linux (32-bit mode) IA.32


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode)  SUN.64


Table 2 Disk Space Requirements for SiVL (in Megabytes) 


Platform Megabytes


amd64 45


linux (32-bit mode) 52
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Table 3 shows the maximum space required for installing Hercules on a 
particular platform. 


Installing the Software


SiVL uses the Synopsys Installer tool, which allows you to use a graphical user 
interface (GUI) or a text script. For information about downloading Synopsys 
Installer and SiVL, see Installing Synopsys Tools.


To install SiVL by EST or from the CD, follow the procedures described in 
Installing Synopsys Tools.


Installing Synopsys Tools shows an example Synopsys media installation 
script for the synthesis tools. SiVL is installed in a similar manner.


SiVL is a stand-alone product and cannot be installed over an existing 
Synopsys product, including a prior version of SiVL. You must create a new 
directory for SiVL.


Note:   


Due to compliance issues concerning the export and distribution of MySQL, 
this SiVL B-2008.09 release package has been modified to remove all 
MySQL binaries and related material. If you are an existing SiVL customer, 
you can still use this release by copying the "...<SIVL_HOME>/sivldb/" 
directory from a previous 2006.12X (or later) package into the installed B-


sparc64 73


Table 3 Disk Space Requirements for Hercules (in Megabytes) 


Platform Megabytes


amd64 91


linux (32-bit mode) 84


sparc64 92


Table 2 Disk Space Requirements for SiVL (in Megabytes)  (Continued)


Platform Megabytes
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2008.09 release package. If you are not an existing SiVL customer, or are 
having problems with above solution, please contact your SiVL CAE or 
Synopsys support staff for installation instructions. 


Setting Up the User Environment


To set up the user environment, you must specify the location of the executable 
file and set the license environment variable.


Specifying the Executable File Location


Add the SiVL directory containing the executable file to the PATH environment 
variable.


If you are using the C shell, add the following line to the .cshrc file:


set path=(SIVL_HOME/bin $path)


If you are using the Bourne, Korn, or Bash shell, add the following line to the 
.profile, .kshrc, or .bashrc file:


PATH=$SIVL_HOME/bin:$PATH
export PATH


where SIVL_HOME is the name of the SiVL installation directory.


Setting the LM_LICENSE_FILE or
SNPSLMD_LICENSE_FILE Environment Variable


You must install the SCL software and define the SNPSLMD_LICENSE_FILE, 
LM_LICENSE_FILE, or another tool-specific variable before you can verify the 
SiVL installation. 


For information about downloading and installing SCL and setting the license 
variable, see Installing Synopsys Tools.


Setting Up SiVL to Use Hercules and IC WorkBench Plus


SiVL requires the Hercules and IC WorkBench Plus tools. For the 
B-2008.09 version of SiVL, you must install Hercules version 
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B-2008.09 and IC WorkBench Plus version A-2007.12. (SiVL is also 
backwards-compatible with IC WorkBench version X-2005.09-SP2.)


Note:   


Hercules, IC WorkBench Plus, and SiVL can be installed on different hosts 
or different platforms. The host names must be specified when the tools call 
for them.


For download and installation instructions, see the installation instructions 
available at http://www.synopsys.com/support/installation/install_guide.html. 


Note:   


The standard installation instructions in the Hercules document also apply 
to service pack releases (for example, 
Y-2004.12-SP3). For the latest information about supported platforms, see 
the product release notes.


To enable SiVL to use Hercules, source the following file:


% source install_dir/setup/hercules_setup.csh


where install_dir is the Hercules installation directory. 


The hercules_setup.csh script sets HERCULES_HOME_DIR and other variables 
and checks whether the appropriate platforms are available. In the 
hercules_setup.csh script, set the value of HERCULES_HOME_DIR to the actual 
Hercules installation directory.


To enable SiVL to use IC WorkBench Plus, set the path to the following:


set path=(ICWB_HOME/bin $path)
where ICWB_HOME is the IC Workbench Plus installation directory.


Verifying the SiVL Installation


To verify the SiVL installation, make sure you are in a directory where you have 
read/write privileges. 


Run a small test case to verify that SiVL runs correctly. Create a working 
directory named sivl_test and perform the following steps:


1. List the available sample .xjc files.


% runlrc -l 


2. Select a sample .xjc file from the list, and copy the file and models to your 
local machine.
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% runlrc -i xjc_file [target_xjc]


Replace xjc_file with the sample file you chose. Supply the name for the 
destination file. SiVL copies the models directory with the appropriate 
models for the sample .xjc file to the working directory.


3. Open the GUI and edit the parameters of the sample file.


a. Enter


% runlrc -e xjc_file


This opens the graphical interface for the script builder and creates a 
new directory called Run.1. Runsets will be generated in this directory. 


b. Turn on the checks you want to run.


c. Select Build > Build Now.


d. Exit the script builder. 


4. Run SiVL from the newly created Run.1 directory. 


% runlrc -r


This runs Hercules in the Run.1 directory. Results are placed in that 
directory as well. Note that the checkpoint data is stored in a directory 
underneath the working directory.


After the run finishes, you should have the following files and directories in 
the sivl_test directory:


-xjc_file
models/
checkpoint/
run_details_checkpoint/
run.1/


5. Launch IC WorkBench Plus,


% icwb -socket port_number &


where port_number is an arbitrary, unused TCP port (between 1024 and 
64000), which will be used to communicate between 
IC Workbench and the analysis tool, Error Analyzer. For example,


% icwb -socket 5555 port_number &


Then load the output GDSII file, lrc_out.gds, located in the Run.1 directory 
(select the correct top cell, not the one with EV... in the name) 
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6. Launch Error Analyzer.


% analysis &


7. In Error Analyzer, select Viewer > Viewer Properties. In the Hostname dialog 
box, enter the host name where IC WorkBench Plus was launched (the 
default entry is localhost). 


8. In the Port dialog box, choose the TCP port specified in step 5 and click OK.


9. In Error Analyzer, create a new database.


a. Select Data > New Error Database. 


b. In the new window, use the Browse button to locate the Cell Map File in 
the top box. 


c. Using the Browse button, locate and insert a database name of your 
choice. 


d. Provide “Sampling Trigger” and “Number of Samples” values in the 
lower boxes. Click OK.


e. Create a new report by choosing Select Data > New Report. In the new 
window, select any error of interest from the list on the left (for example, 
pb...). 


10. From the newly generated table, select one row (or error) with the left mouse 
button; then with the right mouse button, open a menu for this error and 
choose View Error. 


In IC WorkBench Plus, the window zooms to the error corresponding to the 
selection you made in Error Analyzer.


If the installation was successful, you will be able to complete all steps 
without any problems. 
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Installing Sentaurus Lithography
This document contains specific information to prepare for and verify the 
installation of Sentaurus Lithography, as well as links to installation 
instructions.


Note:   The installation instructions in this document are the most up-to-
date instructions available at the time of production. However, 
changes might have occurred. For the latest installation 
information, see the product release notes or documentation.


This document contains the following sections:
■ Media Availability and Supported Platforms
■ Disk Space Requirements
■ Installing the Software
■ Setting Up the User Environment
■ Verifying the Sentaurus Lithography Installation
■ Accessing Sentaurus Lithography Documentation


To install Synopsys tools, it is recommended that you have system 
administrator privileges. You need write permission for the installation 
directory.


Media Availability and Supported Platforms


The Sentaurus Lithography tool is available by electronic software transfer 
(EST) download or as tangible media (DVD or CD, depending on the image 
size). Obtain the appropriate binary executable files based on the operating 
system (OS) you need.


Table 1 lists the supported compute platforms, operating systems, 
corresponding Synopsys platform keywords, and window environments for this 
release. Many platforms require operating system patches. 
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For detailed information, see the Supported Platforms Guide page on the 
Synopsys Web site. Go to http://www.synopsys.com/products/platforms/
sw_platform.html


Under Supported Platforms Guides, select the appropriate foundation for your 
release. This Web page provides information about supported hardware, 
operating systems, and required OS patches. If the required patch described 
on this page is not available from the platform vendor, install the most recent 
patch instead. 


Note:   Versions or releases other than those listed may work correctly 
with the software, but they are not supported explicitly.


Note:   While Windows versions of Sentaurus Lithography are 
supported, for the common installer, no Windows version is 
available.


Note:   The Sentaurus Lithography software is configured so that 
multiple platforms of this version can be installed in a single 
installation directory (install_dir).


If you have any questions, contact your Synopsys sales representative.


For more information on platform support, go to Synopsys Compute Platforms 
Roadmap at: http://www.synopsys.com/Support/Licensing/SupportPlatform/
Pages/PlatformsRoadmap.aspx


Table 1 Supported Platforms, Operating Systems, and Keywords


Platform Operating system Synopsys platform
 keyword


Window 
environment


x86_64 Red Hat Enterprise Linux v4 amd64 (64-bit mode) GNOME


x86 Microsoft Windows Server 2003
R2 Standard Edition 64-bit


Microsoft 
Windows


x86 Microsoft Windows XP 
Professional, Service Pack 2


Microsoft 
Windows
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Disk Space Requirements


To install Sentaurus Lithography, you need approximately 340 MB of free disk 
space.


For real work, you may require more space, depending on the size of your data 
files.


For requirements regarding virtual memory (swap space), refer to the product-
specific documentation.


Installing the Software


Sentaurus Lithography uses the Synopsys Installer tool, which allows you to 
use a graphical user interface (GUI) or a text script. For information about 
downloading Synopsys Installer and Sentaurus Lithography, see Installing 
Synopsys Tools, available at http://www.synopsys.com/support/installation/
install_guide.html.


To install Sentaurus Lithography by EST or from the DVD or CD, follow the 
procedures described in Installing Synopsys Tools.


Installing Synopsys Tools shows an example Synopsys media installation 
script for the synthesis tools. Sentaurus Lithography is installed in a similar 
manner.


Sentaurus Lithography is a stand-alone product and cannot be installed over 
an existing Synopsys product, including a prior version of Sentaurus 
Lithography. You must create a new directory for Sentaurus Lithography.


For Sentaurus Lithography, additional installation instructions can be find in 
slitho_INSTALL_README.txt.


Note:   If you are installing both Sentaurus Lithography and Sentaurus 
Lithography PWA, they should be installed one after the other 
and not at the same time. If you install both packages at the 
same time, select two different target directories.
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Synopsys License Daemon Required
Sentaurus Lithography uses the Synopsys common license daemon snpslmd. 
Version 10.9.3 of the Synopsys daemon is required.


Download snpslmd v10.9.3 from the Synopsys Website and follow the 
instructions there: 
http://www.synopsys.com/Support/Licensing/Licensing/Pages/default.aspx


Destination Control Statement
The technology used in Sentaurus Lithography is strictly controlled for export 
(under Export Classification Number 3D003).


You may not transfer the product or any technical information about the 
product, or make it available to anyone else, unless you have verified that it is 
permitted by export laws.


The product may not be exported or re-exported to China, Russia, Armenia, or 
Vietnam, as well as many other countries, without a valid export license issued 
by a government agency. Foreign nationals of these and other countries are 
restricted from receiving this technology unless they are documented 
permanent residents of countries where export is permitted.


Contact Synopsys export personnel if there are any questions.


Setting Up the User Environment


A platform-independent wrapper script is provided for Sentaurus Lithography. 
This script automatically determines the OS platform at runtime, which 
simplifies the setup required to use Sentaurus Lithography. 


The platform-independent wrapper script is located at install-dir/bin and 
includes -32bit and -64bit options.


Note:   If you select a platform executable file that is not available, an 
automatic switch is made to an available platform based on your 
current environment. No warning message is issued.
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To set up the user environment, you must:
■ Specify the executable file location
■ Set the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE variable


Specifying the Executable File Location
Add the Sentaurus Lithography directory containing the executable file to the 
PATH environment variable.


If you are using the C shell, add the following line to the .cshrc file:


set path=(install_dir/bin $path)


If you are using the Bourne, Korn, or Bash shell, add the following line to 
the .profile or .kshrc file:


PATH=install_dir/bin:$PATH


export PATH


Setting the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve 
your license key file, and define the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE environment variable before you can verify the Sentaurus 
Lithography installation. 


For information about downloading and installing SCL and on setting the 
license variable, see the Synopsys Licensing QuickStart Guide, which is 
available from http://www.synopsys.com/Support/Licensing/Licensing/Pages/
default.aspx.


Verifying the Sentaurus Lithography Installation


To verify the Sentaurus Lithography installation,
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1. Make sure you are in a directory where you have read/write privileges.


% cd $HOME


2. Invoke the tool by entering:


% product -V


If you see information about the product version, production date, and 
copyright, the installation was successful.


Accessing Sentaurus Lithography Documentation


The documentation for Sentaurus Lithography is available as PDF files.


Viewing and Printing Sentaurus Lithography 
Documentation in Portable Document Format
To view and print Sentaurus Lithography documentation in PDF, you must 
have Adobe Acrobat Reader installed on your machine.


Viewing Sentaurus Lithography Online Help
The online Help system is a browser-based HTML Help system. 


To view a Help system, Synopsys recommends the following minimum 
revisions web browsers on the Synopsys-supported platforms (later versions 
should also work):


Platform Operating Systems Supported Browsers


X86_64 Linux 64-bit Red Hat Enterprise Linux 4 Firefox 1.5, 2.0, 3.01


Mozilla 1.7
Netscape Navigator 7.0


X86 Windows 2000 Windows 2000 Firefox 1.5, 2.0, 3.02


Internet Explorer 6.0
Mozilla 1.7
Netscape Navigator 7.0
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The following sections describe:
■ Setting a Default Browser on Windows
■ Setting a Default Browser on UNIX or Linux
■ Setting MIME Types to View PDFs from Help


Setting a Default Browser on Windows
On Windows, Help opens the browser associated with .html files (typically 
Internet Explorer).


To use a browser other than Internet Explorer on Windows:


1. Open the browser that you want to use.


2. Open the Add or Remove Programs applet (available from the Control 
Panel).


3. Choose Set Program Access and Defaults.


4. Select Custom and click the down arrow to display the custom menu.


5. Choose “Use my current Web browser” and click OK.


Result: The next time you click Help, the Help content will appear in your 
selected default browser.


Setting a Default Browser on UNIX or Linux
The Help system finds HTML browsers on UNIX or Linux by searching for 
browsers in this order: Netscape, Mozilla, Internet Explorer. It searches for 
these browsers in the following locations:


X86 Windows XP 
Professional


Windows XP Professional v2002 Firefox 1.5, 2.0, 3.02


Internet Explorer 6.0
Mozilla 1.7
Netscape Navigator 7.0


1. Synopsys recommends using Firefox 3.0 builds 2008052912 or later on Linux.


2. Synopsys recommends using Firefox 3.0 builds 2008052906 or later on Windows.


Platform Operating Systems Supported Browsers
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1. It first searches in the directories listed in your $PATH environment variable 
for the following executables in the following order:


netscape6
netscape
mozilla
iexplorer


2. If Help doesn’t find these executables in your $PATH, it searches first for 
netscape6, then netscape, then mozilla, in the following customary 
locations:


/opt/browser/
/usr/local/bin/
/usr/local/browser/
/usr/bin/browser


3. Finally, it looks for the Internet Explorer executable in this location:


/usr/local/microsoft/bin/iexplorer


To use a browser other than those listed above on UNIX or Linux, there are two 
methods you can use.


Method A: Open the browser you want to use first:


1. Before you use Help, open the browser you want to use, such as Firefox.


2. Then start Help from your Synopsys application.


The Help document will open in the currently opened browser.


Method B: Link the executable you want to use to one of the executables 
(netscape or mozilla) used by Help by default:


• For example, assume that you want to use your Firefox browser executable 
instead of Mozilla, and that both executables are located in /usr/bin. Make a 
symbolic link from the firefox executable to mozilla as follows:


cd /usr/bin
ln -s firefox mozilla


This will cause Help to start Firefox in place of Mozilla when Help is called.


Note:   If you make this change, all users on this system will start 
Firefox instead of Mozilla on this server, in any context.
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Setting MIME Types to View PDFs from Help
Online Help includes PDF versions of the documents, for use in printing. In 
order for links from the Help to the PDF to work, you must set an association in 
your browser for MIME type "application/pdf" with an appropriate PDF viewer 
for your platform. See the documentation for your particular browser for specific 
instructions on creating MIME-type associations.
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Installing SpiceCheck


This document describes how to install the SpiceCheck product.


Note:   


The installation instructions in this document are the most up-to-date 
available at the time of production. However, changes might have occurred. 
For the latest installation information, see the product release notes or 
documentation.


This document provides instructions for both UNIX and Linux platforms. The 
document includes the following sections:
■ Preparing for Installation                                                                                            
■ Installing SpiceCheck                                                               
■ Viewing and Printing SpiceCheck Documentation in Portable Document 


Format
■ Uninstalling SpiceCheck
■ Customer Support


Important:   


Do not install later versions of the SpiceCheck tools over earlier versions of 
the tools.


Preparing for Installation


Before beginning the installation process, read the SpiceCheck Release Notes. 
The release notes are in Portable Document Format (PDF) and are located in 
the electronic software transfer (EST) download directory. They require a PDF 
file reader to view and print them. Check for the following information:
■ Changes in licensing requirements
■ Changes in memory requirements

SpiceCheck Installation Guide 3
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■ The operating system versions on which the software is supported
■ Changes made from prior releases


If you have not already done so, retrieve your license keys from the SmartKeys 
Web page at http://solvnet.synopsys.com/smartkeys.


For detailed licensing information, see the Synopsys Licensing QuickStart 
Guide Web page at http://www.synopsys.com/keys.


Root or administration privileges are not required. 


Supported Platforms and Compilers 


SpiceCheck is available on CD or by EST. Obtain the appropriate binary 
executable files for your operating system. Table 1 lists the supported platforms 
for this release. 


Disk Space and Memory Requirements


The disk space requirement varies depending on the platform and the features 
selected for installation. Table 2 shows the maximum space required for 
installing all SpiceCheck features on a particular platform. Each CD also 
includes this information in the top-level INSTALL_README.wri file. 


Table 1 Supported Platforms, Operating Systems, and Keywords 


Platform Operating system Synopsys platform 
keyword


Window
environment


Sun SPARC Solaris 9 (32-bit and 64-bit) sparcOS5 CDE


IA-32 (X86)
AMD Opteron (64-bit)


Red Hat Enterprise Linux v3, 4 linux (32-bit mode)
linux (64-bit mode)


GNOME


Table 2 Disk Space and Memory Requirements (in Megabytes) 


Platform Software 
(maximum)


Default temporary directory 
location


Temporary disk 
space from CD


Temporary disk 
space from EST


Solaris 82 /var/tmp 82 82


Linux 82 /tmp 82 82
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Installing SpiceCheck


You can install SpiceCheck version C-2009.06 by using a GUI or by using text 
commands. By default, the SpiceCheck installer invokes the installation GUI. To 
install SpiceCheck by using text commands, see Installing Synopsys Tools.


Installing SpiceCheck by EST


Download the SpiceCheck release to any directory. You can obtain the latest 
SpiceCheck download instructions from the SolvNet Release Library.


The UNIX version of SpiceCheck is distributed in a compressed tar file, which 
can be installed in any directory. Root (administrator) permission is not 
required.


To install the software on UNIX systems:


1. Extract the SpiceCheck tar file into a directory (the installation directory). 
Make sure that the installation directory has proper read permission to the 
end users. The distribution tar file is named sc_rev.tar.gz, where rev is the 
revision code.


2. Enter gunzip sc_rev.tar.gz to uncompress the tar file.


3. Enter tar xvf sc_rev.tar to extract the release directory sc_rev from 
the tar file.


4. Enter rm sc_rev.tar to remove the tar file.


5. Append installation_directory/sc_rev/bin to the search path in 
your shell init file (for example, .cshrc for C-shell).


For example, the Solaris release directory contains the following files and 
directories:


File or Directory Description


LICENSE License agreement


bin/ Program executable and license daemon


doc/ Documentation


examples/ SpiceCheck examples


check_lib/ Pre-built SpiceCheck check functions

SpiceCheck Installation Guide 5
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Installing SpiceCheck from a CD


Mounting the CD might require root access privileges. If you do not have root 
access privileges, see your system administrator for instructions on mounting 
the CD. For detailed instructions, see Installing Synopsys Tools.


Setting Up Licenses


Note:   


You must have the SCL daemon version SCL10.9.3 or later to set up your 
license.


SpiceCheck uses Flexlm for license management. If you receive an uncounted 
node-locked evaluation or demo license, no license server needs to be started.


To install an uncounted node-locked evaluation license, append the full path of 
the license file (including the license file name) to the 
SNPSLMD_LICENSE_FILE environment variable.


To install a production or floating license, you need to start the license server by 
entering the following line:


lmgrd -c license.dat


The lmgrd license server automatically invokes the snpslmd vendor daemon. 
Make sure the path to the snpslmd vendor daemon is appended to the 
VENDOR line in your license file. You can find lmgrd and snpslmd in the bin/ 
directory for different platforms. Please consult your system administrator to 
install the floating license. A copy of Flexlm end user's manual is included in the 
doc/ directory. An online user's manual is also available at
http://www.macrovision.com/.


Viewing and Printing SpiceCheck Documentation
in Portable Document Format


To view and print SpiceCheck documentation in Portable Document Format 
(PDF), you must have Adobe Acrobat Reader installed on your machine. To 

6 SpiceCheck Installation Guide
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determine which version of Adobe Reader your operating system requires, see 
Table 3.


Uninstalling SpiceCheck


To uninstall SpiceCheck, delete the entire software installation directory. 


Customer Support


For information about accessing customer support, see Installing Synopsys 
Tools.


Table 3 Platform and Supported Version 


Platform Product documentation 
version


Adobe Reader version 


Linux A-2008.03 or later Adobe Reader 7.0


Sun SPARC  


(Solaris)1


1. On Solaris operating systems, the GNOME desktop manager must be installed to 
support Adobe Reader 7.0.


A-2008.03 or later Adobe Reader 7.0

SpiceCheck Installation Guide 7
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Synthesis Tools Installation Notes
Version D-2010.03 
March 8, 2010 1


These installation notes present information about installing Synopsys synthesis tools in the 
following sections:


• Specific Tools in the Synthesis Group


• Media Availability and Supported Platforms


• Disk Space and Memory Requirements


• Installing the Software


• Setting Up the User Environment


• Configuring the Browser for Design Vision Online Help


• Installing Optional Tools


• Verifying the Synthesis Tools Installation


• Limitations


Note:   
The installation instructions in this chapter are the most up-to-date available at the time 
of production. However, changes might have occurred. For the latest installation 
information, see the product release notes or documentation. 


To obtain the latest product Installation Guide, go to http://www.synopsys.com/install. For 
detailed licensing setup and troubleshooting assistance, see the Licensing QuickStart Guide 
at http://www.synopsys.com/licensing.
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Specific Tools in the Synthesis Group


This installation note covers the following Synopsys synthesis tools: 


• Automated Chip Synthesis


• BSD Compiler


• Design Compiler


• Design Vision


• DesignWare 


• DFT Compiler


• HDL Compiler 


• VHDL Compiler)


• Library Compiler


• Module Compiler


• Power Compiler


If you have purchased any of these tools, you must install the synthesis tools suite. These 
tools are also referred to collectively as the synthesis tool set. 
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Media Availability and Supported Platforms


The synthesis tools are available by EST download upon initial software release, and at a 
later date on DVD (or CD depending on image size). 


Table 1 shows the supported compute platforms, operating systems, Synopsys platform 
keywords, and windowing environments for this release. 


Table 1 Supported Platforms, Operating Systems, and Keywords 


Compute 
platform


Operating system Synopsys platform
keyword


Desktop
windowing 
environment


x86_64 Red Hat Enterprise Linux v4, 51


1. Binary-compatible hardware platform or operating system. Note, however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/qsc for the latest on supported platforms, including required OS patches.


amd64 (64-bit mode)2 
linux (32-bit mode)2


2. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel or AMD x86_64 processors 
running Red Hat Enterprise Linux. 


GNOME 


x86_64 SUSE Linux Enterprise Server v9, 101 suse64 (64-bit mode)
suse32 (32-bit mode)   


KDE 


x86_64 Solaris 10 x86sol64 (64-bit mode) 
x86sol32 (32-bit mode)


CDE 


IBM RS6000 AIX 5.3, 6.11 rs6000 (32-bit mode)
aix64 (64-bit mode)


CDE 


x86 Red Hat Enterprise Linux v4, 51 linux (32-bit mode)2 GNOME 


x86 SUSE Linux Enterprise Server v9,101 suse32 (32-bit mode) KDE 


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode)
sparcOS5 (32-bit mode)


CDE 
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For detailed platform support information, see the Release Specific Support page on the 
Synopsys Qualified System Configuration Web site at the following address:


http://www.synopsys.com/qsc


This Web page provides release-specific information about supported hardware, operating 
systems, and required operating system patches. If the required patch described on this 
page is not available from the platform vendor, install the most recent patch instead.


Synopsys products, including the Synopsys Installer, have been verified against the 
supported platforms as listed in Table 1.


Disk Space and Memory Requirements


This section describes tool disk and memory requirements in the following subsections:


• Minimum Memory Requirements


• Swap Space Requirements


• Accessing Memory Beyond 2 GB With 32-Bit Synthesis Tools


Minimum Memory Requirements
The synthesis tools have the following minimum memory requirements: 


• Physical Memory – 150 MB (1 GB recommended) 


• Swap space – 256 MB (2 GB recommended) 


For large designs, the expected amount of required memory is approximately 1 million bytes 
per 2,000 gates.  


Swap Space Requirements 
The amount of swap space required by the synthesis tools depends on the size and type of 
each circuit design.


Use the following formula to help you determine the minimum amount of available swap 
space required for HDL designs: 
16.3 MB + (5.9 x (size of the design in K gates)).


For example, a 5K-gate design requires 16.3 + (5.9 x 5) = 45.8 MB of available swap space.
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Accessing Memory Beyond 2 GB With 32-Bit Synthesis Tools
Synthesis tools can extend memory beyond 2 GB. Note that available memory is calculated 
as space not used by the OS, the windowing system, or other applications. The following 
synthesis tools can extend memory beyond 2 GB:


• Design Compiler


• DFT Compiler


• HDL Compiler 


• VHDL Compiler 


• Power Compiler


Note:   
Available memory is space not used by the OS, the windowing system, or other 
applications.


To access memory beyond 2 GB, 


1. Make sure your server has at least 4 GB of memory (physical and swap space) available. 


Note:   
Physical memory equals data size plus stack size, and stack size is used before data 
size. Therefore setting stack size to a large value causes problems for designs that 
need to go over 2 GB. If you set the stack size too high, you cannot get enough 
memory for your data. To check the settings, use the limit command at the system 
prompt. 


2. Make sure the system you are using does not have restrictions that prevent you from 
using more than 2 GB of memory.


3. Create unlimited data size in the shell that you are using: C, Bourne, Korn, or Bash. If 
there are system-wide limits on the data size you can create, you can remove them or 
override them. You can do this in one of two ways:


- Enter one of the following commands based on the shell you are using:


For the C shell,


% limit datasize 3800000 


For the Bourne, Korn, or Bash shell,


# ulimit -S -d 3800000 


- Modify the kernel of your server. This approach allows everyone using your server to 
extend memory beyond 2 GB.
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Installing the Software


The synthesis tools use the Synopsys Installer tool, which allows you to use a text script or 
a graphical user interface (GUI). For information about downloading the Synopsys Installer 
and synthesis, see Installing Synopsys Tools, which is available at the following address:


http://www.synopsys.com/install


To install the synthesis tool set, follow the procedures described in Installing Synopsys Tools. 


The synthesis tool set is a stand-alone product and must be installed in an empty directory, 
using the latest version of the Synopsys Installer. Do not install the synthesis tool set over 
an existing Synopsys product, including prior versions of the synthesis tool set. 


Setting Up the User Environment


Configuring the synthesis tools is described in the following sections:


• Specifying the Executable File Location


• Setting the License File Environment Variable


Specifying the Executable File Location 
A platform-independent wrapper script is provided for the synthesis tools. This script 
automatically determines the operating system platform at runtime, which simplifies the 
setup required to use the synthesis tools. 


The platform-independent wrappers are located at install_dir/bin and include the following 
options:


-32bit|-64bit


To set up the environment by using the platform-independent wrapper script, add the 
synthesis tool set bin directory to the PATH environment variable.


• To set up the environment using the C shell, add the following line to the .cshrc file:


set path=(install_dir/bin $path)


• To set up the environment using the Bourne, Korn, or Bash shell, add the following lines 
to the .profile, .kshrc, or .bashrc file:


PATH=install_dir/bin:$PATH
export PATH
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Replace install_dir with the synthesis tool set installation directory.


Setting the License File Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve your license key 
file, and define the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE environment variable 
before you can verify the synthesis tool set installation.


For information about downloading SCL, installing SCL, or setting the license file variable, 
see the Synopsys Licensing QuickStart Guide, which is available at the following address:


http://www.synopsys.com/licensing


Configuring the Browser for Design Vision Online Help


The online Help system is a browser-based HTML Help system designed for viewing in the 
Firefox and Mozilla Web browsers. Supported versions include Firefox 2.0, Firefox 1.5, and 
Mozilla 1.7.


If you prefer to use other browsers, note the following limitations: 


• Online Help does not work in Netscape version 6.0. (Netscape 6.x browsers are not 
supported.) 


• Online Help might work in Netscape versions 4.7x, 4.8, and 7.0, or in other browsers such 
as Internet Explorer or Opera, but it is not tested or supported in these browsers. 


When you use online Help from within the GUI, the directory containing the browser 
executable file must be in the search path specified by your UNIX or Linux $PATH variable.


The default browser is Firefox. To use a different browser, change the 
gui_online_browser variable in your .synopsys_dv_gui.tcl setup file to the browser of 
your choice. You can change the browser for the current session by setting the 
gui_online_browser variable from within the GUI. For example, to change your current 
session browser to Mozilla, execute the following:


set gui_online_browser “mozilla”
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Installing Optional Tools


The synthesis media installation script automatically installs most of the synthesis tools. 
Considerations for tools that require additional installation setup are described in the 
following sections:


• Linking Power Compiler VPOWER to a Verilog-XL Simulator


• Linking Power Compiler VPOWER to the VCS Simulator


• Using SoCBIST With DFT Compiler and TetraMAX


• Using the Model Adaptation System and the Library Quality Assurance System


Linking Power Compiler VPOWER to a Verilog-XL Simulator
VPOWER is the Power Compiler interface to VCS, the Cadence Verilog-XL and NC-Verilog 
simulators, and the MTI Verilog simulator. VPOWER contains user tasks that allow you to 
monitor toggle activity during simulation and to output the information in a form readable by 
Power Compiler. To use VPOWER, link the user tasks to the executable file of your simulator. 


The following sections describe the steps for static-linking VPOWER with a version of the 
Verilog-XL simulator that contains the standard features you normally use at your site and 
includes the toggle count utilities needed for Power Compiler. For information about linking 
VPOWER with other simulators, see the Power Compiler User Guide. 


Note:   
You must perform this installation on a machine that has access to your Verilog-XL 
simulator vendor distribution.


Consult your Verilog system administrator to obtain the following information before 
beginning the VPOWER installation:


• The directory path to your Verilog .o, .a, and .h files


• The directory location of your central Verilog distribution, for obtaining a current site copy 
of the veriuser.c file


This installation requires modification of your veriuser.c file. By obtaining a current site copy 
of the veriuser.c file, you can be sure to include any current site modifications when you 
modify this file.


To install VPOWER,


1. Change to the Synopsys vpower directory.
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2. Modify a copy of your site veriuser.c file.


3. Link the VPOWER user tasks to the simulation executable file.


4. Copy the linked executable file.


The following sections describe these steps.


Changing to the Synopsys Power Directory
All directories listed are relative to the root of the vpower directory: $SYNOPSYS/auxx/syn/
power/vpower, where $SYNOPSYS is the path to the synthesis tool set installation directory.


To change to the Synopsys vpower directory,


1. Make sure the $SYNOPSYS environment variable is set.


% echo $SYNOPSYS


If it is not set, set it to the correct value.


% setenv SYNOPSYS root_directory


2. Change to the Synopsys vpower directory.


% cd $SYNOPSYS/auxx/syn/power/vpower


Modifying the veriuser.c File
To modify the veriuser.c file to define the new toggle count utilities,


1. Change to the vxl/vxl.sample directory, and review the sample veriuser.c file, which shows 
the edits you will have to make.


% cd vxl/vxl.sample


2. Copy your current site version of veriuser.c into the sample directory. To copy veriuser.c, 
you must know the directory location of your central Verilog distribution.


% cp site_location_dir_path/veriuser.c .


By using a current site copy of veriuser.c, you ensure that any existing customizations are 
included in the VPOWER installation.


3. As shown in the sample veriuser.c file, make the following changes in your current site 
copy of veriuser.c:


- Add the following line:


# include "tc_extern.h"
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- Add the following user tasks:


{usertask, 0, 0, 0, tc_set, tc_set_sync, "$toggle_set", 1},
{usertask, 0, 0, 0, tc_start, 0, "$toggle_start", 1},
{usertask, 0, 0, 0, tc_stop, 0, "$toggle_stop", 1},
{usertask, 0, 0, 0, tc_reset, 0, "$toggle_reset", 1},
{usertask, 0, 0, 0, tc_compatibility, 0, "$toggle_count", 1},
{usertask, 0, toggle_report_check, 0, toggle_report, 0, "$toggle_report", 0},
{usertask, 0, 0, 0, read_lib_saif, tc_lib_sync, "$read_lib_saif", 1},
{usertask, 0, 0, 0, read_rtl_saif, tc_set_sync, "$read_rtl_saif", 1},


- Comment out the following line:


char *veriuser_version_str = "";


4. Save your modified veriuser.c file.


5. Exit your text editor and remain in the sample directory to link the executable file.


Linking User Tasks to the Simulation Executable File
 VPOWER provides two ways to link the user tasks to your simulator executable file: by using 
the vconfig utility or by using a UNIX makefile. Each method links your simulator to the 
VPOWER user tasks. Choose the method that you find familiar or comfortable.


Using vconfig to Link the Executable File
The vconfig utility creates a script called cr_vlog. The cr_vlog script links your Verilog-XL 
simulator’s executable file to the VPOWER user tasks. You must define the name of the 
executable file created by cr_vlog, for example, verilog_toggle.


To use the vconfig method to link your executable file,


1. Use your vconfig utility or an equivalent utility to generate the cr_vlog script or an 
equivalent script.


2. In the script, set an environment variable pointing to the directory of the generated library 
archive. For example (if you are using Solaris 7 or later),


setenv PPLILIB "../../lib-sparcOS5/libvpower.a"


3. In cr_vlog, look for the line that includes the math libraries:


-lm \


4. Add a line above this line to include the libvpower.a library. For example,


$PPLILIB \
-lm \
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5. Run cr_vlog.


% cr_vlog


This script links your executable file to the VPOWER user tasks and creates the 
customized executable file called verilog_toggle. For details about linking the 
programmable language interface (PLI) by using the vconfig utility, see the Power 
Compiler User Guide.


Proceed to “Copying the Linked Executable File.”


Using a Makefile to Link the Executable File
Using the UNIX make command, you can use a makefile to link your Verilog-XL executable 
file to the VPOWER user tasks. The makefile creates a modified executable file called 
verilog_toggle.


Two makefiles exist: Makefile.sol and Makefile.hp.


To use the makefile method to link your executable file,


1. Using a text editor such as vi, edit the appropriate makefile to set variable values for 
VERILOG_LIB and VERILOG_INC.


Modify the lines in the makefile to read according to your data. For example, enter


VERILOG_LIB = path1
VERILOG_INC = path2


where path1 is the path to your Verilog distribution .o and .a files, and path2 is the path to 
your Verilog distribution .h files.


The VERILOG_LIB variable must point to the directory path of the vlog.o and 
omnitasks.o files. The VERILOG_INC variable must point to the directory path of the 
acc_user.h and veriuser.h files.


2. Save the modified makefile and exit your text editor.


3. Use the make utility to link the executable file.


% make -f Makefile.platform


The platform extension is sol or hp.


The make command uses the modified makefile to link your executable file, creating a 
customized executable file called verilog_toggle.
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Copying the Linked Executable File
After you create your customized executable file, change the permissions so that the file is 
not writable, and copy it to a directory suitable for group access.


Enter the following commands at the UNIX prompt:


% chmod ogu-w verilog_toggle


This removes write access to other, group, and user.


% cp verilog_toggle site_verilog_bin_location


This copies the file to the site_verilog_bin_location directory for group access.


Linking Power Compiler VPOWER to the VCS Simulator
VPOWER is the Power Compiler interface to VCS, the Cadence Verilog-XL and NC-Verilog 
simulators, and the MTI Verilog simulator. VPOWER contains user tasks that allow you to 
monitor toggle activity during simulation and to output the information in a form readable by 
Power Compiler. To use VPOWER, link the user tasks to the executable file of your simulator. 


The following sections describe the steps for static-linking VPOWER with to a version of VCS 
that contains the standard features you normally use at your site and includes the toggle 
count utilities needed for Power Compiler. For information about linking VPOWER with other 
simulators, see the Power Compiler User Guide. 


Note:   
The PLI library has been tested with VCS version 3.0 and later versions. 


To install VPOWER,


1. Change to the Synopsys vpower directory.


2. Modify a copy of the PLI table file.


3. Compile the simulation executable file.


The following sections describe these steps.
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Changing to the Synopsys VPOWER Directory
All directories listed are relative to the root of the VPOWER directory: $SYNOPSYS/auxx/
syn/power/vpower, where $SYNOPSYS is the path to the synthesis tool set installation 
directory


1. Make sure the $SYNOPSYS environment variable is set.


% echo $SYNOPSYS


If it is not set, set it to the correct value.


% setenv SYNOPSYS synthesis_root_directory


2. Change to the Synopsys VPOWER directory.


% cd $SYNOPSYS/auxx/syn/power/vpower


Modifying the PLI Table File
To modify the PLI table file (vpower.tab) to define the new toggle count utilities, 


1. Change to the vcs/vcs.sample directory, and review the sample vpower.tab file, which 
shows the edits you will have to make.


% cd vcs/vcs.sample


2. Make the necessary changes to the vpower.tab file.


Compiling the Simulation Executable File
VCS is a compiled simulator, so you must compile your designs along with VCS libraries to 
make a simulation executable file. To add PLI functionality to the simulation executable file, 
you need to link an extra PLI library when you compile your designs.


For Solaris the appropriate PLI library is


../../lib-sparcOS5/libvpower.a


You normally get a VCS simulation executable file by entering the following command at the 
UNIX prompt:


% vcs -Mupdate your_verilog_design_files compiler_options


 To link with the PLI library, enter 


% vcs -Mupdate  -P $SYNOPSYS/auxx/syn/power/vpower/vcs/vcs.sample/vpower.tab \   
your_verilog_design_files compiler_options \


 $SYNOPSYS/auxx/syn/power/vpower/lib-sparcOS5/libvpower.a
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This generates an executable file called simv that includes PLI functionality.


Note:   
You can copy vpower.tab and libvpower.a into any file locations that are convenient for 
you.


Using SoCBIST With DFT Compiler and TetraMAX
To insert SoCBIST into your design, you need DFT Compiler, which installs with the 
synthesis tools. You also need TetraMAX if you want to use the SoCBIST pattern generation 
functionality. You can install TetraMAX as an overlay on the synthesis tools or as a 
stand-alone installation. For required SoCBIST environment variables, see “Specifying the 
Executable File Location” on page 1-6.”


Using the Model Adaptation System and the Library Quality 
Assurance System
Important:   


The Library Quality Assurance System (check_ccs_lib) is scheduled to become obsolete 
beginning with the D-2010.12 release. Beginning with the D-2010.03 release, 
check_ccs_lib issues the following warning message:


"Warning: check_ccs_lib command is scheduled to become obsolete in 
the 2010.12 release."


Library Compiler can perform various types of library formatting operations. Each operation 
converts or merges one or more existing library files in Liberty (.lib) format to create a new 
library, which is written out in Liberty format. The set of formatting capabilities is called the 
Model Adaptation System. The Library Quality Assurance System checks libraries in .lib 
format for errors in consistency and accuracy. It can perform library validation and library 
correlation.


To run the Model Adaptation System operations and the Library Quality Assurance System 
utility, you must set the path for the SYNOPSYS_NCX_ROOT variable in your .cshrc file and 
point it to the NCX_Install_Directory location. If you are using the C shell, add the following 
line to the .cshrc file:


setenv SYNOPSYS_NCX_ROOT path_to_NCX_Install_Directory


If you are using the Bourne, Bash, or Korn shell, add these lines to the .profile, .bashrc, or 
.kshrc file:
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SYNOPSYS_NCX_ROOT = path_to_NCX_Install_Directory
export SYNOPSYS_NCX_ROOT
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Verifying the Synthesis Tools Installation


To verify installation, 


1. Make sure you are in a directory, such as your home directory, where you have read/write 
privileges. For example, to change to your home directory, you might execute


% cd $HOME


2. Invoke the synthesis tools on a licensed machine. For example, invoke Design Compiler, 
Library Compiler, or Design Vision by entering one of the following commands: 


% install_dir/platform/syn/bin/dc_shell-topographical 


% install_dir/platform/syn/bin/lc_shell 


% install_dir/platform/syn/bin/design_vision 


where install_dir is the synthesis tool set installation directory and platform is the 
appropriate platform (see Table 1). 


Note:   
You can verify other synthesis tools by using the preceding command. Simply replace the 
executable file name with the name of another synthesis tool.


If you see information about the product version, production date, and copyright, the 
installation was successful. 


Limitations


Milkyway Support


When using Milkyway, Design Compiler does not support the IBM RS/6000 AIX (32) or IBM 
RS/6000 AIX (64) platforms.
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Installing TCAD Products
This document contains specific information to prepare for and verify 
installation of TCAD products, as well as links to installation instructions.


Note:   The installation instructions in this document are the most up-to-
date instructions available at the time of production. However, 
changes might have occurred. For the latest installation 
information, see the product release notes or documentation.


This document contains the following sections:
■ Media Availability and Supported Platforms
■ Disk Space Requirements
■ Installing the Software
■ Setting Up the User Environment
■ Verifying the TCAD Installation
■ Accessing TCAD Documentation


To install Synopsys tools, it is recommended that you have system 
administrator privileges. You need write permission for the installation directory.


Media Availability and Supported Platforms


TCAD products are available by electronic software transfer (EST) download or 
as tangible media (DVD or CD, depending on the image size). Obtain the 
appropriate binary executable files based on the operating system (OS) you 
need.


Table 1 on page 4 lists the supported compute platforms, operating systems, 
corresponding Synopsys platform keywords, and window environments for this 
release. Many platforms require operating system patches.
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For detailed information, see the Supported Platforms Guide page on the 
Synopsys Web site. Go to http://www.synopsys.com/qsc and select the 
appropriate foundation for your release. This Web page provides information 
about supported hardware, operating systems, and required OS patches. If the 
required patch described on this page is not available from the platform vendor, 
install the most recent patch instead.


Note:   TCAD products are configured so that multiple platforms of this 
version can be installed in a single installation directory 
(install_dir).


Table 2 lists TCAD products with their associated versions and supported 
platforms. For the latest product-specific platform information, see the release 
notes for your tool.


Table 1 Supported platforms, operating systems, and keywords


Platform Operating system Synopsys platform 
keyword


Window 
environment


x86_64 Red Hat Enterprise Linux v4, v51


1. Binary-compatible hardware platform or operating system. Note, however, that binary compatibility is 
not guaranteed. See http://www.synopsys.com/qsc for the latest information on supported platforms.


amd64 (64-bit mode)2 


2. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel EM64T or AMD 
Opteron running Red Hat Enterprise Linux. See http://www.synopsys.com/qsc for the latest information on 
supported platforms.


GNOME


x86_64 SUSE Linux Enterprise Server v9, v101 suse64 (64-bit mode)2 KDE


IBM RS6000 AIX 5.3 aix64 (64-bit mode)
rs6000 (32-bit mode)


CDE


x86 Red Hat Enterprise Linux v4, v51 linux (32-bit mode)2 GNOME


Table 2 TCAD products and supported platforms


Product Version Platform keyword


Raphael D-2010.03 amd64, linux, rs6000


TCAD Sentaurus D-2010.03 amd64, linux, aix64, suse64


Taurus Medici D-2010.03 amd64, linux, rs6000
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Disk Space Requirements


Make sure you have enough disk space for the installation of TCAD products. 
The disk space requirement varies depending on the platform and the tool 
selected for installation. Table 3 shows the maximum space required for 
installing TCAD products on one platform.


Installing the Software


The TCAD products use the Synopsys Installer tool, which allows you to use a 
graphical user interface (GUI) or a text script. For information about 
downloading Synopsys Installer and the TCAD products, see Installing 
Synopsys Tools, available at http://www.synopsys.com/support/installation/
install_guide.html.


To install the TCAD tools by EST or from the CD, follow the procedures 
described in Installing Synopsys Tools.


Taurus TSUPREM-4 D-2010.03 amd64, linux, rs6000


Taurus Modeling Environment X-2005.10 hp32, linux, rs6000, sparcOS5


Table 3 TCAD disk space requirements


Product Disk space [MB]


Raphael 350


TCAD Sentaurus 4700


Taurus Medici 350


Taurus TSUPREM-4 275


Taurus Modeling Environment 355


Table 2 TCAD products and supported platforms


Product Version Platform keyword
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Installing Synopsys Tools shows an example Synopsys media installation script 
for the synthesis tools. The TCAD software is installed in a similar manner.


The TCAD tools are stand-alone products and cannot be installed over other 
existing Synopsys products. You must create a new directory for each TCAD 
product (such as Sentaurus and Taurus).


Sentaurus can be installed in the same Sentaurus directory (STROOT) used for 
earlier Sentaurus releases (this is recommended). However, do not install 
Sentaurus in an ISE directory (ISEROOT) containing an earlier ISE TCAD 
software release.


The Sentaurus examples and the Sentaurus Device Monte Carlo files are 
packaged separately from the base Sentaurus package. If you want to install 
either of these packages, you should install them in the same Sentaurus 
directory where the base package was installed.


Setting Up the User Environment


A platform-independent wrapper script is provided for TCAD products. This 
script automatically determines the OS platform at run-time, which simplifies 
the setup required to use TCAD products.


The platform-independent wrapper script is located at install-dir/bin and 
includes -32bit and -64bit options.


Note:   If you select a platform executable file that is not available, an 
automatic switch is made to an available platform based on your 
current environment. No warning message is issued.


To set up a new tool user, you must:
■ Set the STROOT environment variable.
■ Modify the search path.
■ Set the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE environment 


variable.
■ Set the STDB environment variable for Sentaurus Workbench.
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Setting the STROOT Environment Variable
If you are installing Sentaurus, each user must have the STROOT environment 
variable set to the Sentaurus installation directory. In the following example, the 
Sentaurus installation directory is named /usr/sentaurus.
■ If you use the C shell, add the following line to your $HOME/.cshrc file:


setenv STROOT /usr/sentaurus


■ If you use the Bourne, Korn, or Bash shell, add the following line to 
the .profile, .kshrc, or .bashrc file:


STROOT=/usr/sentaurus
export STROOT


Modifying Your Search Path
If the TCAD program is not found on the search path, it will need to be added. 
In the following examples, the TCAD directory on your system is named /usr/
tcad.
■ If you use the C shell, add the following line to your $HOME/.cshrc file:


set path=(/usr/tcad/bin $path)


■ If you use the Bourne, Korn, or Bash shell, add the following line to 
the .profile, .kshrc, or .bashrc file:


PATH=/usr/tcad/bin:$PATH


Note:   If you are installing Sentaurus and have earlier ISE TCAD 
releases installed on your system, ensure the Sentaurus bin 
directory precedes the ISE TCAD installation in your search 
path. For example:


% set path=($STROOT/bin $ISEROOT/bin $path)


Setting the License File Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve your 
license key, and define the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
environment variable before you can verify the TCAD installation.
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For information about downloading and installing SCL and on setting the 
license variable, see the Synopsys Licensing QuickStart Guide, which is 
available from http://www.synopsys.com/Support/LI/Licensing/Pages/
default.aspx.


Setting the STDB Environment Variable
If you will be using Sentaurus Workbench, create a directory to store your 
Sentaurus Workbench projects (if one does not exist) and set the STDB 
environment variable to it. For example:
■ Create a directory to store your Sentaurus Workbench projects:


mkdir $HOME/STDB


■ If you use the C shell, add the following line to your $HOME/.cshrc file:


setenv STDB $HOME/STDB


■ If you use the Bourne, Korn, or Bash shell, add the following lines to 
the .profile, .kshrc, or .bashrc file:


STDB=$HOME/STDB
export STDB


Using Sentaurus Options
The following command-line options can be used with any Sentaurus tool to 
select specific versions or releases of the Sentaurus tools:


-releases


Lists all available releases in the Sentaurus installation directory under 
$STROOT (for example, C-2009.06, A-2008.09-SP1, A-2008.09).


-versions


Lists all subversions in a particular release directory. (This may include a 
patch or engineering release, for example, version 1.0 of A-2008.09.) Use 
-releases and –versions together to list the entire set for a given tool.


-rel release


Specifies execution of a particular release. For example, -rel A-2008.09 
overrides the STRELEASE and STROOT_LIB environment variables and 
executes the A-2008.09 release of the tool.
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-ver version


Specifies execution of a particular subversion. Uses the specified version 
instead of the default version. For example, -ver 1.3 overrides the default 
version and executes version 1.3 of the tool.


-64bit


Invokes the 64-bit binary files when they are available, but not the default. 
Setting the STBITS environment variable to 64 makes this the default 
behavior.


-32bit


Invokes the 32-bit binaries on platforms where both 64-bit and 32-bit 
binaries are available. The default is 64-bit. Setting the STBITS environment 
variable to 32 makes this the default behavior.


Troubleshooting


Error 1
Error Message:


Xlib:  connection to "machine:0.0" refused by server
Xlib:  Client is not authorized to connect to Server
Bad return from XOpenDisplay


Explanation:


The program does not have permission to open a window on the display.
■ Check to be sure the DISPLAY environment variable is set correctly on the 


machine where the tool is being run.
■ On the console of the display, enter the command:


% xhost +
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Error 2
Error Message:


tmafork: command not found


Explanation:


The tmafork TCAD utility cannot be found.
■ Check to be sure the TCAD bin directory is in the search path.
■ Check to be sure the TCAD utilities are installed correctly and that tmafork 


is linked to the TCAD bin directory.


Error 3
Error Message:


*** Open Pipe = signal 13 code 0


Explanation:


The TMAPLOT process is terminating abnormally, leaving the TCAD program 
piping data to a broken pipe.
■ Check to be sure TMAPLOT works correctly outside the TCAD program by 


entering the following command:


% tmaplot x test


■ If TMAPLOT works correctly outside the TCAD program, the error is most 
likely caused by insufficient system resources to start the TMAPLOT 
process. Check your system resources when running the TCAD program to 
be sure there are enough resources to run the TMAPLOT process.


Error 4
System hangs on large simulation in Linux


Explanation:


If your Linux system is configured to enable memory overcommit and you run a 
simulation that exceeds the memory resources on your system, it can lead to 
the system hanging. Check whether memory overcommit is switched on, on 
your machine, by typing the following command in a shell:


/sbin/sysctl vm|grep overcommit_memory


A value different from 2 means overcommit is switched on.
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To avoid this behavior, you can use ulimit (bash) or limit (csh) to prevent 
using more memory than your system has available. For example, on a 
machine with 4 GB RAM, for bash, type:


ulimit -d 4096000


For csh, type:


limit datasize 4096000


Alternatively, have your system administrator disable memory overcommit.


Verifying the TCAD Installation


To verify the TCAD installation:


1. Make sure you are in a directory where you have read/write privileges:


% cd $HOME


2. Invoke the tool by entering:


% product -V


If you see information about the product version, production date, and 
copyright, the installation was successful.


Accessing TCAD Documentation


The documentation for TCAD products is available as PDF files.


Viewing and Printing TCAD Documentation in Portable 
Document Format
To view and print TCAD documentation in Portable Document Format (PDF), 
you must have Adobe Acrobat Reader installed on your machine. To determine 
which version of Adobe your operating system requires, see Table 4 on 
page 12.
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Adobe Reader Full-Text Search Issue on UNIX
Table 4 shows which version of Adobe Reader you need to use with a particular 
release. It also indicates whether full-text search is available for a particular 
platform and release.


Note:   If you use a version of Adobe Reader earlier than 7.0, you may 
not be able to use the full-text search on UNIX for the current 
release.


For detailed information, see the SolvNet article, An error 
message appears when doing a full-text search of Synopsys 
product documentation (go to https://solvnet.synopsys.com/
retrieve/017761.html).


Table 4 Platform and supported version


Platform Product documentation 
version


Full-text search 
available


Adobe Reader version


Linux Y-2006.03, Y-2006.06 or later


X-2005.12 or earlier


Yes


No


Adobe Reader 7.0


Any version

12 Installing TCAD Products
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These installation notes present information about installing TetraMAX version D-2010.03 in 
the following sections:


• Media Availability and Supported Platforms


• Memory Requirements


• Installing the Software


• Setting Up the User Environment


• Verifying the TetraMAX Installation


If you are installing TetraMAX stand-alone, to ensure a successful installation, complete the 
following procedures before beginning the installation process:


• Create the Synopsys root directory.


• Define the SYNOPSYS environment.


Note:   
The installation instructions in this chapter are the most up-to-date available at the time 
of production. However, changes might have occurred. For the latest installation 
information, see the product release notes or documentation.


To obtain the latest product Installation Guide, go to http://www.synopsys.com/install. For 
detailed licensing setup and troubleshooting assistance, see the Licensing QuickStart Guide 
at .http://www.synopsys.com/licensing.

Copyright © 2010 Synopsys, Inc. All rights reserved. See 
http://www.synopsys.com/Company/Pages/Copyright.aspx for additional terms and conditions.
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Media Availability and Supported Platforms


TetraMAX is available by electronic software transfer (EST) download upon initial software 
release, and at a later date on DVD (or CD depending on image size).


Table 1 shows the supported compute platforms, operating systems, Synopsys platform 
keywords, and windowing environments for this release. 


For detailed platform support information, see the Release Specific Support page on the 
Synopsys Qualified System Configuration Web site at the following address:


http://www.synopsys.com/qsc


Table 1 Supported Platforms, Operating Systems, and Keywords 


Compute 
platform


Operating system Synopsys platform 
keyword


Desktop 
windowing 
environment


x86_64 Red Hat Enterprise Linux v4, 51


1. Binary-compatible hardware platform or operating system. Note, however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/qsc for the latest on supported platforms, including required OS patches.


amd64 (64-bit mode)2


linux (32-bit mode)2


2. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel or AMD x86_64 processors 
running Red Hat Enterprise Linux.


GNOME


x86_64 SUSE Linux Enterprise Server v9, 101 suse64 (64-bit mode)


suse32 (32-bit mode)


KDE


x86_64 Solaris 10 x86sol64 (64-bit mode)


x86sol32 (32-bit mode)


CDE


x86 Red Hat Enterprise Linux v4, 51 linux (32-bit mode)2 GNOME


x86 SUSE Linux Enterprise Server v9,101 suse32 (32-bit mode) KDE


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode)


sparcOS5 (32-bit mode)


CDE


IBM RS6000 AIX 5.3, 6.11 aix64 (64-bit mode)


rs6000 (32-bit mode)


CDE

Media Availability and Supported Platforms 2
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This Web page provides release-specific information about supported hardware, operating 
systems, and required operating system patches. If the required patch described on this 
page is not available from the platform vendor, install the most recent patch instead.


Synopsys products, including the Synopsys Installer, have been verified against the 
supported platforms as listed in Table 1.


Memory Requirements


The recommended minimum physical memory is 1 GB. The recommended minimum swap 
space is 2 GB. 


Installing the Software


This section describes Synopsys license key requirements and the two types of installation 
for TetraMAX ATPG and TetraMAX IddQTest, version D-2010.03. 


You can install TetraMAX as a stand-alone product or as an overlay product.


• Stand-alone (txs)


Install TetraMAX stand-alone in its own directory. The product ID for the stand-alone 
version is txs. For instructions, see  “Stand-Alone Installation.”


• Overlay (tx)


Install TetraMAX overlay in the same directory as the appropriate release of the synthesis 
tools. For instructions, see ““Overlay Installation.” The product ID for the overlay version 
is tx.


Note:   
If you are going to install TetraMAX IddQTEST, you must install it first (see “Optional 
Installation of IddQTest”), then install TetraMAX ATPG as an overlay to the synthesis 
tools.


TetraMAX uses the Synopsys Installer, which allows you to use a text script or a graphical 
user interface (GUI). For information about downloading the Synopsys Installer, see 
Installing Synopsys Tools, which is available at the following address:


http://www.synopsys.com/install


To install TetraMAX, follow the procedures described in Installing Synopsys Tools. TetraMAX 
is a standalone product and must be installed in an empty directory, using the latest version 
of the Synopsys Installer. Do not install TetraMAX over an existing Synopsys product, 
including prior versions of TetraMAX.

Memory Requirements 3
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Stand-Alone Installation
TetraMAX uses the Synopsys Installer tool, which allows you to use a text script or a 
graphical user interface (GUI). For information about downloading Synopsys Installer and 
TetraMAX, see Installing Synopsys Tools at http://www.synopsys.com/install.


TetraMAX stand-alone is a complete installation of all TetraMAX applications. It must be 
installed in its own directory and not over an existing synthesis release.


To perform stand-alone installation, 


1. To install TetraMAX follow the procedures described in the document Installing Synopsys 
Tools at http://www.synopsys.com/install. (For stand-alone installation, download the 
txs_version_platform.tar files and the txs_version_common.tar file.) The Installing 
Synopsys Tools document provides a Synopsys media installation script for the synthesis 
tools. TetraMAX is installed in a similar manner. 


Note:   
When you are prompted to select the product you want to install, enter txs to perform 
a stand-alone installation.


2. Make sure that your licensing software is installed the license environment variable is set. 
See “Setting the License File Environment Variable.”


Overlay Installation
TetraMAX uses the Synopsys Installer tool, which allows you to use a graphical user 
interface (GUI) or a text script. For information about downloading Synopsys Installer and 
TetraMAX, see Installing Synopsys Tools at http://www.synopsys.com/install.


When you attempt to install overlay software over an earlier release, the installation script 
looks only at the foundation identifier, for example, W or X; it does not look for the release 
month and year. This enables you to install a later tool version for the same foundation 
release over an earlier tool version. For example, you could install TetraMAX version 
V-2004.06 over version V-2003.12 of the synthesis tools.


Do not attempt to install an earlier version of TetraMAX (for example, V-2003.12) over a later 
version of the synthesis tools (V-2004.06). This installation is not supported, but the installer 
script will not stop you from doing it if overlay installation is allowed. Also, note that a Y 
foundation release cannot overlay a X foundation release, nor can a X foundation release 
overlay a W or V foundation release.


You perform overlay installation in the directory in which you installed the Synopsys 
synthesis tools ($SYNOPSYS). You must log on as the same user who installed the 
Synopsys synthesis tools so that you have write permission in the $SYNOPSYS directory.

Installing the Software 4
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Note:   
If you have not installed the Synopsys synthesis tools, install them before proceeding with 
overlay installation (see Synthesis Tools Installation Notes). If you do not have the 
synthesis tools installed, the installation of TetraMAX overlay will not be allowed.


To perform overlay installation,


1. To install TetraMAX follow the procedures described in the document Installing Synopsys 
Tools at http://www.synopsys.com/install. (For overlay installation, download the 
tx_version_platform.tar files and the tx_version_common.tar file.).The Installing 
Synopsys Tools document provides a Synopsys media installation script for the synthesis 
tools. TetraMAX is installed in a similar manner


Note:   
When you are prompted to select the product you want to install, enter tx to perform 
an overlay installation.


2. Make sure your Synopsys license server and license key file are set up to work with the 
synthesis tools. If you encounter problems, see the SCL documentation, Synopsys 
Common Licensing QuickStart Guide at http://www.synopsys.com/keys and the 
Common Licensing Installation and Administration Guide.


Optional Installation of IddQTest
You must install the IddQTest option before you install TetraMAX ATPG. IddQTest requires a 
separate license. 


To install IddQTest,


1. To install IddQTest follow the procedures described in the document Installing Synopsys 
Tools at http://www.synopsys.com/install. This document provides a Synopsys media 
installation script for the synthesis tools. IddQTest is installed in a similar manner. 


Note:   
When you are prompted to select the product you want to install, enter idq to perform 
the installation.


2. Make sure that your licensing software is installed the license environment variable is set, 
see “Setting the License File Environment Variable.”


3. Install TetraMAX ATPG as an overlay to the synthesis tools, see “Overlay Installation.”

Installing the Software 5



http://www.synopsys.com/install

http://www.synopsys.com/install





TetraMAX Installation Notes Version D-2010.03

Setting Up the User Environment


To set up the user environment, you must specify the location of the executable file and set 
the license file environment variable.


 When you define the TetraMAX root directory, you can now use the $SYNOPSYS environment 
variable. 


Note:   
For backward compatibility, you can still set $SYNOPSYS_TMAX. If $SYNOPSYS_TMAX is set, 
it will override $SYNOPSYS. 


Specifying the Executable File Location
A platform-independent wrapper script is provided for TetraMAX. This script automatically 
determines the operating system platform at runtime, which simplifies the setup required to 
use TetraMAX.


The platform-independent wrapper script is located at install_dir/bin and includes the 
following options:


-32bit | -64bit


To set up the environment by using the platform-independent wrapper script, add the 
TetraMAX bin directory to the PATH environment variable.


• To set up the environment using the C shell, add the following line to the .cshrc file:


set path=(install_dir/bin $path)


• To set up the environment using the Bourne, Korn, or Bash shell, add the following lines 
to the .profile, .kshrc, or .bashrc file:


PATH=install_dir/bin:$PATH
export PATH


Replace install_dir with the TetraMAX installation directory.


Setting the License File Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve your license key 
file, and define the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE environment variable 
before you can verify the TetraMAX installation.
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For information about downloading SCL, installing SCL, or setting the license file variable, 
see the Synopsys Licensing QuickStart Guide, which is available at the following address:


http://www.synopsys.com/licensing


Note:   
Optional features such as at-speed fault models, power-aware ATPG and scan 
compression require separate licenses. For specific information on the licenses required 
for TetraMAX commands, install the product and see the online Help topic 
“Understanding TetraMAX License Usage.” 


Running TetraMAX in 64-Bit Mode 
In 64-bit mode, TetraMAX supports both the shell and GUI on Solaris, AMD64, and Suse64 
platforms.


To invoke TetraMAX ATPG in 64-bit mode, use the -64 switch. 


% tmax -64 [other options]


An alternative method is to set the TMAX_64BIT variable to true (or to any string other than null).


% setenv TMAX_64BIT true
% tmax [other options]


Configuring Online Help
TetraMAX Online Help can now be run in most standard HTML browsers, such as Mozilla, 
Mozilla Firefox, SeaMonkey, Internet Explorer, and Safari. Formerly, Online Help could only be 
displayed in a proprietary browser. To set up a default browser for Help, do the following:


setenv USER_HELP_BROWSER /usr/bin/firefox 
alias firefox '/usr/bin/firefox'


Verifying the TetraMAX Installation


To verify the TetraMAX installation, 


1. Make sure you are in a directory where you have read/write privileges.


% cd $HOME


2. Invoke the TetraMAX GUI by entering the following command on a licensed machine:


% tmax


If the GUI appears, the installation was successful.

Verifying the TetraMAX Installation 7





		TetraMAX®ATPG Installation Notes Version D-2010.03 March 8, 2010

		Media Availability and Supported Platforms

		Memory Requirements

		Installing the Software

		Stand-Alone Installation

		Overlay Installation

		Optional Installation of IddQTest



		Setting Up the User Environment

		Specifying the Executable File Location

		Setting the License File Environment Variable

		Running TetraMAX in 64-Bit Mode

		Configuring Online Help



		Verifying the TetraMAX Installation








1


VCS Installation Notes
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This document describes how to install the VCS product.


This document contains the following sections:


• “Media Availability and Supported Platforms”


• “Accessing Memory Beyond 2 GB With 32-Bit Tools”


• “Installing the Software”


• “Setting the Environment Variables”


• “Verifying the VCS Installation”


• “Customer Support”


The instructions in this chapter also apply to VCSi.
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Media Availability and Supported Platforms


The VCS tool is available by EST or on CD. Obtain the appropriate binary 
executable files based on the operating system you need. Table 1-1 shows 
the supported platforms for this release.


Table 1-1 Platforms and Keywords 


Platform Operating system Synopsys platform 
keyword


Additional
keywords


x86_64 Red Hat Enterprise Linux v4, 51


1. Binary-compatible hardware platform or operating system. Note,  however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/products/platforms for the latest information.


amd64 (64-bit mode)
linux (32-bit mode)2


2. Binary-compatible hardware platform or operating system. Note,  however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/products/platforms for the latest information.


amd64_32


x86_64 SUSE Enterprise Linux v9, 101 suse64 (64-bit mode)
suse32 (32-bit mode)2


suse64_32


x86_64 Solaris 10 x86sol64 (64-bit mode)
x86sol32 (32-bit mode)


IBM RS6000 AIX 5.3 rs6000 (32-bit mode)
aix64 (64-bit mode)


x86 Red Hat Enterprise Linux v4, 51 linux (32-bit mode)2


x86 SUSE Enterprise Linux v9, 101 suse32 (32-bit mode)


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode)
sparcOS5 (32-bit mode)


sparc64_32
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Accessing Memory Beyond 2 GB With 32-Bit Tools


In general, UNIX-based systems support a maximum memory of 2 GB for 
32-bit processes. However, the VCS tool can extend memory beyond 2 GB.


Note:   
Available memory is space not used by the OS, the windowing 
system, or other applications.


To access memory beyond 2 GB,


1. Make sure your server has Solaris 9 (or later) loaded.


2. Make sure your server has at least 4 GB of memory (physical and swap 
space) available.


Note:   
Physical memory equals data size plus stack size, and stack size is 
used before data size. Therefore setting stack size to a large value 
causes problems for designs that need to go over 2 GB. If you set the 
stack size too high, you cannot get enough memory for your data. To 
check the settings, use the limit command at the system prompt. 
For more information, see “Configuring the Environment” in 
Installing Synopsys Tools.


3. Make sure the system you are using does not have restrictions that 
prevent you from using more than 2 GB of memory.


4. Create unlimited data size in the shell that you are using: C, Bourne, 
Korn, or Bash. If there are system-wide limits on the data size you can 
create, you can remove them or override them. You can do this in one 
of two ways:


- Enter one of the following commands:


For the C shell,
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% limit datasize 3800000 


For the Bourne, Korn, or Bash shell,


# ulimit -S -d 3800000 


- Modify the kernel of your server. This approach allows everyone 
using your server to extend memory beyond 2 GB.


Installing the Software


VCS uses the Synopsys Installer tool, which allows you to use a graphical 
user interface (GUI) or a text script. For information about downloading 
Synopsys Installer and VCS, see “Downloading the Software” in Installing 
Synopsys Tools.


To install VCS by EST or from the CD, follow the procedures described in 
Installing Synopsys Tools.


Example 1-1 in Installing Synopsys Tools shows a Synopsys media 
installation script for the synthesis tools. VCS is installed in a similar 
manner.


VCS is a stand-alone product and cannot be installed over an existing 
Synopsys product, including a prior version of VCS. You must create a new 
directory for VCS.
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Setting the Environment Variables


Setting the Environment Variables


This section discusses the following environment variables:


• VCS_HOME 


• SNPSLMD_LICENSE_FILE 


It is recommended that you place these variables in your $HOME/.cshrc or 
$HOME/.profile file as your default settings. 


Setting the VCS_HOME Environment Variable
Follow these steps.


1. Set the VCS_HOME environment variable to point to the installation 
root directory.


- If you are using the C shell, add the following line to the .cshrc file:


% setenv VCS_HOME /usr/synopsys/vcs/version


- If you are using the Bourne shell, add these lines to the .profile or 
.bashrc file:


% VCS_HOME=/usr/synopsys/vcs/version
  export VCS_HOME


2.  Add $VCS_HOME/bin to your search path.


- If you are using the C shell, enter


set path=($VCS_HOME/bin $path)


- If you are using the Bourne shell, enter


PATH=$VCS_HOME/bin:$PATH
export PATH
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3. (Optional) To include the optional utilities shipped with VCS in the 
path, do the following:


- If you are using the C shell, enter


set path = ($VCS_HOME/bin \
$VCS_HOME/`$VCS_HOME/bin/vcs -platform`/bin \
$VCS_HOME/`$VCS_HOME/bin/vcs -platform`/util \
$path)


- If you are using the Bourne shell, enter


PATH=$VCS_HOME/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/util \
 $PATH
 export PATH


Setting the SNPSLMD_LICENSE_FILE
Environment Variable
You must install the SCL software and define the 
SNPSLMD_LICENSE_FILE variable before you can verify the VCS 
installation. 


For information about downloading and installing SCL, see Chapter 30, 
“Synopsys Common Licensing (version 10.9.2)” in Installing Synopsys 
Tools. For detailed instructions on setting the license variable, see “Setting 
Up the Licensing Environment” in Installing Synopsys Tools.







7


Verifying the VCS Installation


Verifying the VCS Installation


To verify the VCS installation,


1. Make sure you are in a directory where you have read/write privileges.


% cp –r $VCS_HOME/doc/examples/basic-hdl/verilog/comp_run .
% cd ./comp_run
% vcs ./addr4.v -R -debug


If VCS creates a simv file in the comp_run directory, the VCS 
installation was successful.  


2. Run the DVE GUI on each installed platform by entering 


% dve


3. Exit the GUI by choosing File > Exit in the DVE window.


Customer Support


The VCS support page on the Synopsys Web site is regularly updated with 
the latest information. To check this page for application notes, online help 
updates, and other valuable information, go to


http://www.synopsys.com/products/simulation/simulation.html


You can also send an e-mail message to VCS Support at


 vcs_support@synopsys.com
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VCS MX Installation Notes
Version D-2009.12
December 2009 1


This document contains instructions about installing the VCS MX (VHDL 
Simulation and Verilog Simulation) tool.


This document contains the following sections:


• “Media Availability and Supported Platforms”


• “Accessing Memory Beyond 2 GB With 32-Bit Tools”


• “Installing the Software”


• “Setting the Environment Variables”


• “Verifying the VCS MX Installation”


The instructions in this chapter also apply to VCS MXi.
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Media Availability and Supported Platforms


The VCS MX tool is available by EST or on CD. Obtain the appropriate 
binary executable files based on the operating system you need. Table 1-1 
shows the supported platforms for this release.


Table 1-1 Platforms and Keywords 


Platform Operating system Synopsys platform 
keyword


Additional
keywords


x86_64 Red Hat Enterprise Linux v4, 51


1. Binary-compatible hardware platform or operating system. Note,  however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/products/platforms for the latest information.


amd64 (64-bit mode)
linux (32-bit mode)2


2. Binary-compatible hardware platform or operating system. Note,  however, that binary compatibility is not 
guaranteed. See http://www.synopsys.com/products/platforms for the latest information.


amd64_32


x86_64 SUSE Enterprise Linux v9, 101 suse64 (64-bit mode)
suse32 (32-bit mode)2


suse64_32


x86_64 Solaris 10 x86sol64 (64-bit mode)
x86sol32 (32-bit mode)


IBM RS6000 AIX 5.3 rs6000 (32-bit mode)
aix64 (64-bit mode)


x86 Red Hat Enterprise Linux v4, 51 linux (32-bit mode)2


x86 SUSE Enterprise Linux v9, 101 suse32 (32-bit mode)


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode)
sparcOS5 (32-bit mode)


sparc64_32
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Accessing Memory Beyond 2 GB With 32-Bit Tools


In general, UNIX-based systems support a maximum memory of 2 GB for 
32-bit processes. However, the VCS MX tool can extend memory beyond 
2 GB.


Note:   
Available memory is space not used by the OS, the windowing 
system, or other applications.


To access memory beyond 2 GB,


1. Make sure your server has Solaris 9 (or later) loaded.


2. Make sure your server has at least 4 GB of memory (physical and swap 
space) available.


Note:   
Physical memory equals data size plus stack size, and stack size is 
used before data size. Therefore setting stack size to a large value 
causes problems for designs that need to go over 2 GB. If you set the 
stack size too high, you cannot get enough memory for your data. To 
check the settings, use the limit command at the system prompt. 
For more information, see “Configuring the Environment” in 
Installing Synopsys Tools.


3. Make sure the system you are using does not have restrictions that 
prevent you from using more than 2 GB of memory.


4. Create unlimited data size in the shell that you are using: C, Bourne, 
Korn, or Bash. If there are system-wide limits on the data size you can 
create, you can remove them or override them. You can do this in one 
of two ways:


- Enter one of the following commands:
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For the C shell,


% limit datasize 3800000 


For the Bourne, Korn, or Bash shell,


# ulimit -S -d 3800000 


- Modify the kernel of your server. This approach allows everyone 
using your server to extend memory beyond 2 GB.


Installing the Software


VCS MX uses the Synopsys Installer tool, which allows you to use a 
graphical user interface (GUI) or a text script. For information about 
downloading Synopsys Installer and VCS MX, see “Downloading the 
Software” in Installing Synopsys Tools


To install VCS MX by EST or from the CD, follow the procedures 
described in Installing Synopsys Tools


Example 1-1 in Installing Synopsys Tools shows a Synopsys media 
installation script for the synthesis tools. VCS MX is installed in a similar 
manner.


VCS MX is a stand-alone product and cannot be installed over an existing 
Synopsys product, including a prior version of VCS MX. You must create 
a new directory for VCS MX.


Setting the Environment Variables


This section discusses the following environment variables:


• VCS_HOME
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Setting the Environment Variables


• SNPSLMD_LICENSE_FILE 


It is recommended that you place these variables in your $HOME/.cshrc or 
$HOME/.profile file as your default settings. 


Setting the VCS_HOME Environment Variable
Follow these steps.


1. Set the VCS_HOME environment variable in the shell that you are using 
in which the root_directory argument is the name of the 
VCS MX root directory.


- If you are using the C shell, enter 


% setenv VCS_HOME /vcs_mx/build/vcs_mx/vcs_mxD-2009.12


- If you are using the Bourne shell, enter 


% VCS_HOME=/vcs_mx/build/vcs_mx/vcs_mxD-2009.12
export VCS_HOME


2. Add the directory containing the VCS MX executable files to the PATH 
environment variable.


- If you are using the C shell, add the following line to the .cshrc file:


set path=($VCS_HOME/bin $path)


- If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:


PATH=(path:$VCS_HOME/bin)
export PATH
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Setting the SNPSLMD_LICENSE_FILE
Environment Variable
You must install the SCL software and define the 
SNPSLMD_LICENSE_FILE variable before you can verify the VCS MX 
installation. 


For information about downloading and installing SCL, see Chapter 30, 
“Synopsys Common Licensing (version 10.9.2)” in Installing Synopsys 
Tools. For detailed instructions on setting the license variable, see “Setting 
Up the Licensing Environment” on page 30-8 in Installing Synopsys Tools.


Verifying the VCS MX Installation


To verify the VCS MX installation, 


1. Make sure you are in a directory where you have read/write privileges.


% cp –r $VCS_HOME/doc/examples/basic-hdl/verilog/comp_run .
% cd ./comp_run
% vcs ./addr4.v -R -debug


If you see information about the product version, production date, and 
copyright, the installation was successful. 


2. Run the DVE GUI on each installed platform by entering 


% dve


3. Exit the GUI by choosing File > Exit in the DVE window.
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These installation notes present information about installing Vera version D-2009.12 in the following 
sections:


• Media Availability and Supported Platforms


• Disk Space and Memory Requirements


• Installing the Software


• Setting Up the User Environment


• Verifying the Vera Installation


Note:
The installation instructions in this chapter are the most up-to-date available at the time of 
production. However, changes might have occurred. For the latest installation information, see the 
product release notes or documentation.


See also http://www.synopsys.com/Support/Licensing/Installation/Pages/default.aspx for additional 
installation and licensing information.
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Media Availability and Supported Platforms
Vera is available by electronic software transfer (EST) download upon initial software release, and at 
a later date on DVD (or CD depending on image size).


Table 1 shows the supported compute platforms, operating systems, Synopsys platform keywords, 
and windowing environments for this release. 


Table 1 Supported Platforms, Operating Systems, and Keywords 


Compute platform Operating system Synopsys platform 
keyword


Desktop 
windowing 
environment


x86_64 Red Hat Enterprise Linux v4.6 amd64 (64-bit mode)


linux (32-bit mode)1


1. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel EM64T or AMD Opteron processors 
running Red Hat Enterprise Linux.


GNOME


x86_64 SUSE Enterprise Linux v9 suse64 (64-bit mode)
suse32 (32-bit mode)


KDE


x86_64 Solaris 9, 102


2. Binary-compatible hardware platform or operating system. Note, however, that binary compatibility is not guaranteed. See 
http://www.synopsys.com/Support/Licensing/SupportPlatform/ReleaseSupport/Pages/default.aspx for the latest on supported 
platforms, including required OS patches.


x86sol64 (64-bit mode)
x86sol32 (32-bit mode)


CDE


x86 Red Hat Enterprise Linux v4.6 linux (32-bit mode)1 GNOME


x86 SUSE Enterprise Linux v9 suse32 (32-bit mode) KDE


Sun SPARC Solaris 9, 10 sparc64 (64-bit mode)
sparcOS5 (32-bit mode)


CDE


IBM RS6000 AIX 5.3 aix64 (64-bit mode)
rs6000 (32-bit mode)


CDE
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Disk Space and Memory Requirements
The disk space requirement depends on the platform. Table 2 shows the minimum space required for 
installing Vera on a particular platform.


The minimum physical memory required is 150 MB. The recommended minimum physical memory 
is 1 GB. The minimum swap space required is 256 MB. The recommended minimum swap space is 
2 GB. For large designs, the expected amount of required memory is approximately 1 million bytes 
per 2,000 gates.


Accessing Memory Beyond 2 GB With 32-Bit Tools
Vera can extend memory beyond 2 GB. 


Note:   
The available memory is calculated as space not used by the operating system (OS), the 
windowing system, or other applications.


Table 2 Disk Space Requirements (in Megabytes) 


Synopsys platform keyword Megabytes


amd64 635


linux 889


suse64 650


suse32 883


x86sol64 889


x86sol32 889


sparc64 699


sparcOS5 993


aix64 462


rs6000 462
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To access memory beyond 2 GB,


1. Make sure your server has at least 4 GB of memory (physical and swap space) available.


Note:   
Physical memory equals data size plus stack size. Stack size is used before data size. Therefore, 
setting stack size to a large value causes problems for designs that are larger than 2 GB. If you 
set the stack size too high, you cannot get enough memory for your data. To check the settings, 
enter the limit command at the system prompt.


2. Make sure the system you are using does not have restrictions that prevent you from using more 
than 2 GB of memory.


3. Create unlimited data size using the C, Bourne, Korn, or Bash shell. If there are system-wide 
limits on the data size you can create, you can remove them or override them.


• Enter one of the following commands based on the shell you are using:


For the C shell,


% limit datasize 3800000 


For the Bourne, Korn, or Bash shell,


# ulimit -S -d 3800000 


• Modify the kernel of your server. This approach allows everyone using your server to extend 
memory beyond 2 GB.


Installing the Software
Vera uses the Synopsys Installer, which allows you to use a text script or a graphical user interface 
(GUI). For information about downloading the Synopsys Installer, see Installing Synopsys Tools, 
which is available at the following address:


http://www.synopsys.com/Support/Licensing/Installation/Pages/default.aspx


To install Vera, follow the procedures described in Installing Synopsys Tools. Vera is a standalone 
product and must be installed in an empty directory, using the latest version of the Synopsys Installer. 
Do not install Vera over an existing Synopsys product, including prior versions of Vera.


Setting Up the User Environment
To set up the user environment, you must specify the location of the executable file and set the license 
file environment variable.

Installing the Software 4
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Specifying the Executable File Location
A platform-independent wrapper script is provided for Vera. This script automatically determines the 
operating system platform at runtime, which simplifies the setup required to use Vera.


The platform-independent wrapper script is located at install_dir/bin and includes the following 
options:


-32bit | -64bit


Note:   
If you select a platform executable file that is unavailable, an automatic switch is made to an 
available platform based on your current environment. No warning message is issued.


To set up the environment by using the platform-independent wrapper script, add the Vera bin 
directory to the PATH environment variable.


• To set up the environment using the C shell, add the following line to the .cshrc file:


set path=(install_dir/bin $path)


• To set up the environment using the Bourne, Korn, or Bash shell, add the following line to the 
.profile, .kshrc, or .bashrc file:


PATH=install_dir/bin:$PATH
export PATH


Replace install_dir with the Vera installation directory.


Setting the License File Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve your license key file, and 
define the SNPSLMD_LICENSE_FILE environment variable before you can verify the Vera 
installation.


For information about downloading SCL, installing SCL, or setting the license file variable, see the 
Synopsys Licensing Quickstart Guide, which is available at the following address:


http://www.synopsys.com/Support/Licensing/Licensing/Pages/default.aspx


Verifying the Vera Installation
To verify the Vera installation, 


1. Make sure you are in a directory where you have read/write privileges.

Verifying the Vera Installation 5
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% cd $HOME


2. Invoke the tool by entering one of the following commands on a licensed machine.


• To start Vera in shell mode, enter


% install_dir/bin/<Product Executable Name>


• To start Vera in GUI mode, enter


% install_dir/bin/<Product Executable Name> -gui


Replace install_dir with the Vera installation directory.


If you see information about the product version, production date, and copyright or if the GUI 
appears, the installation was successful.

Verifying the Vera Installation 6
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Installing XA
This document contains specific information to prepare for and verify 
installation of the XA add-on to NanoSim and HSIM, as well as links to 
installation instructions.


Note:   The installation instructions in this document are the most up-to-
date instructions available at the time of production. However, 
changes might have occurred. For the latest installation 
information, see the product release notes or documentation. 


This document contains the following sections:
■ Media Availability and Supported Platforms
■ Disk Space Requirements
■ Installing the Software
■ Setting Up the User Environment
■ Verifying the XA Installation
■ Accessing XA Documentation


To install Synopsys tools, it is recommended that you have system 
administrator privileges. You need write permission for the installation directory.


Media Availability and Supported Platforms


The XA tool is available by electronic software transfer (EST) download or as 
tangible media (DVD or CD, depending on the image size). Obtain the 
appropriate binary executable files based on the operating system (OS) you 
need. Table 1 lists the supported compute platforms, operating systems, and 
corresponding Synopsys platform keywords for this release. Many platforms 
require operating system patches.


For detailed information , see the Supported Platforms Guide page on the 
Synopsys Web site. Go to http://www.synopsys.com/qsc and select the 
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appropriate foundation for your release. This Web page provides information 
about supported hardware, operating systems, and required OS patches. If the 
required patch described on this page is not available from the platform vendor, 
install the most recent patch instead.


Note:   The XA software is configured so that multiple platforms of this 
version can be installed in a single installation directory 
(install_dir).


Table 1 Supported Platforms, Operating Systems, and Keywords


Platform Operating system Synopsys platform 
 keyword


x86_64 Red Hat Enterprise Linux v4, 51


1.Binary-compatible hardware platform or operating system. Note, however, that binary 
compatibility is not guaranteed. See http://www.synopsys.com/qsc for the latest information 
on supported platforms. 


amd64 (64-bit mode)  
linux (32-bit mode) 2


2. The 32-bit (x86) and 64-bit (x86_64) Linux software is binary compatible with the Intel 
EM64T or AMD Opteron running Red Hat Enterprise Linux. ee http://www.synopsys.com/
qsc for the latest information on supported platforms. 


x86_64 SUSE Linux Enterprise Server v9, 


101
suse64 (64-bit mode) 
suse32 (32-bit mode)   


x86_64 Solaris 10 x86sol64 (64-bit mode) 
x86sol32 (32-bit mode)


x86 Red Hat Enterprise Linux v4, 51 linux (32-bit mode)2


x86 SUSE Linux Enterprise Server 


v9,101
suse32 (32-bit mode)


Sun SPARC Solaris 9, 101 sparc64 (64-bit mode) 
sparcOS5 (32-bit mode)

2 Installing XA
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Disk Space Requirements


Make sure you have enough disk space for XA installation. For a full installation 
on one platform, 380 MB is recommended. The disk space requirement varies 
depending on the platform and the tool selected for installation. Table 2 shows 
the maximum space required for installing each product on a particular 
platform. 


Installing the Software


XA uses the Synopsys Installer tool, which allows you to use a graphical user 
interface (GUI) or a text script. For information about downloading Synopsys 
Installer and XA, see Installing Synopsys Tools, available at http://
www.synopsys.com/support/installation/install_guide.html.


To install XA, follow the procedures described in Installing Synopsys Tools.


Installing Synopsys Tools shows an example Synopsys media installation script 
for the synthesis tools. XA is installed in a similar manner.


Table 2 Disk Space Requirements (in Megabytes)  


Operating system Megabytes


Platform-independent files (Base MB) 110


x86sol32 271


x86sol64 301


linux 273


amd64 287


sparc64 321


sparcOS5 302


suse32 273


suse64 286

Installing XA 3
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XA is a stand-alone product and cannot be installed over an existing Synopsys 
product, including a prior version of XA. You must create a new directory for 
XA.


Setting Up the User Environment


A platform-independent wrapper script is provided for XA. This script 
automatically determines the OS platform at runtime, which simplifies the setup 
required to use XA.


The platform-independent wrapper script is located at install-dir/bin and 
includes -32bit and -64bit options.


Note:   If you select a platform executable file that is not available, an 
automatic switch is made to an available platform based on your 
current environment. No warning message is issued.


Setting up the user environment is described in these sections:
■ Specifying the Executable File Location
■ Setting the License File Environment Variable


Specifying the Executable File Location
Add the XA directory containing the executable file to the PATH environment 
variable.
■ If you are using the C shell, add the following line to the .cshrc file:


set path=(install_dir/bin $path)


■ If you are using the Bourne, Korn, or Bash shell, add the following line to the 
.profile, .kshrc, or .bashrc file:


PATH=install_dir/bin:$PATH
export PATH


Setting the License File Environment Variable
You must install the Synopsys Common Licensing (SCL) software, retrieve your 
license key file, and define the SNPSLMD_LICENSE_FILE or 
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LM_LICENSE_FILE environment variable before you can verify the XA 
installation. 


For information about downloading and installing SCL and on setting the 
license variable, see the Synopsys Licensing QuickStart Guide, which is 
available from http://www.synopsys.com/Support/Licensing/Licensing/Pages/
default.aspx.


Verifying the XA Installation


To verify the XA installation,


1. Make sure you are in a directory where you have read/write privileges.


% cd $HOME


2. Invoke the tool by entering 


% xa -V


If you see information about the product version, production date, and 
copyright, the installation was successful. 


Accessing XA Documentation


The documentation for XA is available as PDF files or as online Help.


Viewing and Printing XA Documentation in 
Portable Document Format
To view and print XA documentation in PDF, you must have Adobe Acrobat 
Reader installed on your machine.


Viewing XA Online Help
The XA online Help system is a browser-based HTML Help system. 

Installing XA 5
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To view a Help system, Synopsys recommends the following minimum 
revisions web browsers on the Synopsys-supported platforms (later versions 
should also work):


The following sections describe:
■ How to Set a Default Browser on Windows
■ How to Set a Default Browser on UNIX or Linux
■ Setting MIME Types to View PDFs from Help


Platform Operating Systems Supported Browsers


IBM RS6000 AIX 32- 
and 64-bit


AIX 5.3 Firefox 1.5 
Mozilla 1.7


SunSPARC  
Solaris 32- & 64-bit


Solaris 9 or 101


1. Synopsys does not recommend using Netscape Navigator to view Help on Solaris.


Firefox 1.5, 2.0 
Mozilla 1.7


X86 (IA-32) 32-bit & 
Linux 32-bit 


RedHat Enterprise Linux 4 or 5 
SUSE Linux Enterprise Server 9 
or 10


Firefox 1.5, 2.0, 3.02 
Mozilla 1.7 
Netscape Navigator 7.0


2. Synopsys recommends using Firefox 3.0 builds 2008052912 or later on Linux.


X86_64 Linux 64-bit Red Hat Enterprise Linux 4 or 5 
SUSE Linux Enterprise Server 9 
or 10


Firefox 1.5, 2.0, 3.02 
Mozilla 1.7 
Netscape Navigator 7.0


X86 Windows 2000 Windows 2000 Firefox 1.5, 2.0, 3.03 
Internet Explorer 6.0 
Mozilla 1.7 
Netscape Navigator 7.0


3. Synopsys recommends using Firefox 3.0 builds 2008052906 or later on Windows.


X86 Windows XP 
Professional


Windows XP Professional v2002 Firefox 1.5, 2.0, 3.03 
Internet Explorer 6.0 
Mozilla 1.7 
Netscape Navigator 7.0
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How to Set a Default Browser on Windows
On Windows, Help opens the browser associated with .html files (typically 
Internet Explorer).


To use a browser other than Internet Explorer on Windows:


1. Open the browser that you want to use.


2. Open the Add or Remove Programs applet (available from the Control 
Panel).


3. Choose Set Program Access and Defaults.


4. Select Custom and click the down arrow to display the custom menu.


5. Choose “Use my current Web browser” and click OK.


Result: The next time you click Help, the Help content will appear in your 
selected default browser.


How to Set a Default Browser on UNIX or Linux
The Help system finds HTML browsers on UNIX or Linux by searching for 
browsers in this order: Netscape, Mozilla, Internet Explorer. It searches for 
these browsers in the following locations:


1. It first searches in the directories listed in your $PATH environment variable 
for the following executables in the following order:


netscape6
netscape
mozilla
iexplorer


2. If Help doesn’t find these executables in your $PATH, it searches first for 
netscape6, then netscape, then mozilla, in the following customary 
locations:


/opt/browser/
/usr/local/bin/
/usr/local/browser/
/usr/bin/browser


3. Finally, it looks for the Internet Explorer executable in this location:


/usr/local/microsoft/bin/iexplorer


To use a browser other than those listed above on UNIX or Linux, there are two 
methods you can use.

Installing XA 7
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Method A: Open the browser you want to use first:


1. Before you use Help, open the browser you want to use, such as Firefox.


2. Then start Help from your Synopsys application.


The Help document will open in the currently opened browser.


Method B: Link the executable you want to use to one of the executables 
(netscape or mozilla) used by Help by default:


• For example, assume that you want to use your Firefox browser executable 
instead of Mozilla, and that both executables are located in /usr/bin. Make a 
symbolic link from the firefox executable to mozilla as follows:


cd /usr/bin
ln -s firefox mozilla


This will cause Help to start Firefox in place of Mozilla when Help is called.


Note:   If you make this change, all users on this system will start 
Firefox instead of Mozilla on this server, in any context.


Setting MIME Types to View PDFs from Help
Online Help includes PDF versions of the documents, for use in printing. In 
order for links from the Help to the PDF to work, you must set an association in 
your browser for MIME type "application/pdf" with an appropriate PDF viewer 
for your platform. See the documentation for  your particular browser for 
specific instructions on creating MIME-type associations.
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